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Introduction

InFusion eForms is standards-based J2EE electronic forms environment that provides out-of-box
workflow to support both XML-based IBM Workplace Forms and Adobe PDF forms with point-and-click
simplicity. inFusion eForms allows business users to take the lead in managing critical business forms
routing and processing without the usual IT complexity. Since 2001, inFusion eForms has been widely
recognized by industry experts and customers. Most recently, inFusion eForms won the 2007 IBM Lotus
Chief Technology Officer Innovation Award and the 2007 IBM Lotus Best Workplace Forms Solution
Finalist honor.

1.1

Overview

The forms are centrally stored on a server, which eliminates the need for users to maintain and track
multiple versions of the same form. Users can see the status of submitted forms at any time by using
predefined “Views”. Users can perform the following general tasks:

Create, Fill in, Save, and Submit forms (Section 2)
View and Manipulate forms that you have previously created including:
•
•
•
•
•

Completed (Section 4.4)
Disapproved (Section 4.5)
Draft (Section 4.1)
Prepared (Section 4.2)
Submitted (Section 4.3)

Route Forms
•
•
•
•

Route a Form to different users (Section 3)
Change Reviewer (Section 4.3)
Takeback a Form (Section 4.3)
Copy a Form (Section 4.3)

View and Process forms including those you previously reviewed including:
•
•
•
•

Approved (Section 5.3)
Awaiting your Approval (Section 5.1)
Batch Approval Forms (Section 5.2)
Disapproved (Section 5.4)

Search your forms (Section 6)
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2
2.1

Create a Form
Selecting a New Form

You may create a new form by selecting the “Create a Form” view under CREATE A FORM.
Choose “Create a Form” will display all available new forms. Forms in this view can be sorted by Name
and Number. To sort the forms, select one of the options from the “Sort By” drop down list.

2.2

Filling in a Form

To open a form, click on the respective Workplace Forms
title.

, PDF

or HTML

icon next to the form

The PDF form opens via the PDF Reader within the browsers.

The Workplace Forms form opens via the Workplace Forms Viewer within the browser.

In situations where Internet Explorer or Workplace Forms Viewer is absent, the Workplace Forms form
can open as a HTML form within the browser through the translation of the WebForms Server. (Requires
Workplace Forms Server)

When the author accesses the form, it will open with editable fields. There are many different types of
data fields and each form may have different validation and directions. To enter information, navigate to
the field by pressing the tab key or clicking on the field.
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Pre-Filled Data: When a form is first opened, some fields may have data already filled in, for example,
your name, phone number, and address. These fields can be read from your User Profile.
Field Descriptions: When the mouse hovers over a field, its description will display in a pop-up box (or
the browser status bar for the Workplace Form in HTML).

Signature Fields - Some PDF forms may contain fields for signatures. Instead of allowing a user to type
directly into the field, a signature button is provided. Clicking on this button will automatically insert the
current user’s name and the current date.

2.3

Selecting a Form Action

When ready to submit a form, you will need to choose an option from the “Select an Option” drop down
menu; usually this is located on the top right corner of each page.
For a new form, the following options may be available:
Exit Without Saving: Closes the form without saving any data
and returns you to the list of forms. If this was a new form, the
document will be deleted.
Save and Exit: Saves the form and data as a draft version.
The saved form is listed in the “Draft” view under FORMS YOU
CREATED.
Save: Saves the form data and redirects you back to the form
for further editing.
Submit: Submits the form with the data to the workflow. The submitted form is listed in the “Submitted”
view under FORMS YOU CREATED.
Complete: For Fill and Print forms, marks the form as completed.
Save Local PDF: This option is only available to PDF forms. The system will email current user a copy
of the PDF form. The emailed version cannot be edited.
Add Attachments: Attachments, Images and Rich Text can be added via the Add Attachments page.
When submitting a form, it may automatically be signed with the submitter’s “electronic” signature, unless
already signed.
The submitted form will be listed in the “Submitted” view under FORMS YOU CREATED.

User Documentation

Page 3

2.3.1

Using the Add Attachments Page

Sometimes, additional information, such as copies of receipts for an expense reimbursement, is required
for a form. The options page allows a user to add files, images, and comments. When an action with the
“with Options” ability selected for the form, the user will be redirected to the options page.

1. Add Attachments
• To add attachments, click on the ‘Browse’ button to search for a file to attach.
• Select the file and click ‘Open’.
• To add another attachment, click on ‘Select Another File’.
2. Add Images
• To add images, click on the ‘Browse’ button to search for an image file to attach.
• Select the image file and click ‘Open’.
• To add another image, click on ‘Select Another File’.
• When you save the form, the image will be inserted into the page.
3. Insert Comments
•
•
•

Enter text in the comments box.
Format the text as necessary.
When saving the form, the formatted text will be inserted into the page.

When users or reviewers view a form after attachments have been added, the “View Attachments” option
will appear in the selection list. Users will be able to view the document without modifying it.
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3

Route a Form

The workflow is defined by Administrators. Depending on the workflow definition, a requestor has
different form actions after filling in a form. The workflow may be Fill and Print, Manual, Manual by
Requestor, or Automatic.

3.1

Automatic Workflow

Forms with an automatic workflow will automatically be routed to the next reviewer without prompting the
current reviewer. The workflow administrator defines who the next reviewer is, what options that reviewer
should have, and whether or not the next reviewer should receive an email notification. For example, the
administrator can set an option for a workflow to automatically send the form to the requestor’s supervisor
as defined in the user’s Profile.
When a form with automatic workflow is successfully routed to the next reviewer, a message similar to the
following will appear:

3.2

Fill and Print Forms

A Fill and Print form allows the user to fill out the form and print it as well as save a copy on the server.
Fill and Print forms do not have a workflow process associated with them. Form can be saved, printed, or
completed. To print the document, select Print from the browser’s File pull-down menu, or click on the
print button on the viewer’s tool bar.
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3.3

Manual Workflow

Manual workflow allows you to select the next reviewer(s) and the options that they can use to route the
form.

Step 1: Select the Next Reviewer
Click on the address book icon
to search for and select the next reviewer. Choosing “I am the
Author of This Form” will designate you as the preparer of the form and set the next reviewer as the
author. This option is only available for the requestor of the form. The preparer can view the form in the
“Prepared” view under FORMS YOU CREATED.
Step 2: Choose the Review Options
As the requestor, you have the ability to set the options that the next user will be able to use in a manual
workflow. To select multiple options, hold down the control (Ctrl) key while you click the desired options.
The review options you pick will appear in the action list for the next reviewer. See section 5.1.2 for a
detailed explanation of the options.
•

Approve/Disapprove: Allows the Approve and Disapprove options. Choosing Approve will route
the form to the next reviewer, if one is available. Choosing Disapprove will terminate the
workflow process.

•

Review: Allows reviewers to view document without making any changes, then continue or
terminate workflow.

•

Save as Draft: Allows the reviewer to save changes before routing the form to the next reviewer.
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•

Cancel Form: Ends the workflow process without disapproving the form. It’s useful when a
submitted form is no longer valid.

•

Send to another Reviewer: Allows users to route the form to a different reviewer.

•

Request Information: Routes the form to another reviewer without incrementing the workflow
step. After the user has responded to the request for additional information, the form is
automatically routed back to the requestor.

•

Save PDF Locally: If it’s a PDF form, this option allows users to request a flattened copy of the
PDF be emailed to them. If it’s Lotus form, the flatten version of the form is presented in a new
window from the browser.

•

Complete: Gives the reviewer the option to approve and completes the workflow process.

•

Exit Without Saving: Allow reviewer to exit the form without making any changes.

•

Process: Approves and terminates the workflow process. Similar to the Complete option.

Step 3: Notification Options
This controls what notification, if any, should be emailed to the next reviewer. The following options are
available:
•

No Notification: No email will be sent to the next reviewer.

•

Use the default notification: Sends the next reviewer the default notification e-mail.

•

Use my custom notification message: Sends the next reviewer an e-mail with the message
you entered in the edit field.

•

Include custom message with the default notification: Sends the next reviewer the default
notification e-mail plus the message you entered in the edit field.

Step 4: Reminder Options
The author of the form has the option to set reminders for the current approvers/reviewers throughout the
workflow.
•

Send reminder email to reviewer(s) every [N] days: if option is checked and a number is set
for N, then the current reviewer(s) will receive reminder emails every N days if they don’t continue
or terminate the workflow process.

•

Send reminder email to reviewer(s) on [day of week]: if option is checked, then the current
reviewer(s) will receive reminder emails every “day of week” if they don’t continue or terminate
the workflow process.

•

Send the author an email if form is not reviewer after N days: if this option is checked and a
number is set for N, then the author will receive a notification email if the next reviewer doesn’t
continue or terminate the workflow process in N days.

Step 5: Submit the Form
Click on “Send Form” to send the form to the next reviewer, or click on “Cancel Form” to save the
changes made in the form without routing the form.

3.4

Manual By Requestor

Manual By Requestor workflow allows the document author to define the entire workflow when the form is
submitted. The number of review levels, the reviewer for each level, and the options available to each
user can be specified.
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Step 1: Select the Reviewer
Click on the address book icon
to open the lookup and select the reviewer for this review level.
Choosing “Make this reviewer the document author” will designate the current user as the preparer of the
form and set the next reviewer as the author. This option is only available for the requestor of the form.
The preparer can view the form in the “Prepared” view under FORMS YOU CREATED.
Selecting the Make Current Reviewer the Document Author option will designate you as the preparer of
the form and set the user at this level as the author. As the preparer, you will only be able to view the
form in the “Prepared” view under FORMS YOU CREATED.

Step 2: Prevent Pullbacks after This Review Level
If this option is selected, the form cannot be taken back by the author once this level is completed. If this
option is not selected, the author may take back the form at any time during the review process.
Step 3: Choose Reviewer Permissions
As the submitter, you have the ability to set the options that each review level user will be able to utilize.
To select multiple options, hold down the control (Ctrl) key while you click the desired option. The review
options you pick will appear in the action list for the next reviewer. Go to section 1.3.3 for an explanation
of the form options.
Step 4: Set Notification Options
Unique notification options may be set for each review level. Optionally, notification options for all review
levels may be set by clicking the Global Notification Options link. Clicking either link open a window with
the following options:
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Time Limit Option: Set the number of days an approver has to review the form.
Reminder Option: Select to send an email reminder to review the document every [X] number of
days, or send a reminder once a week on a specified day. Selecting “Notification Only (reviewer
cannot edit document)”, will only send an email to notify for review with no option to
approve/disapprove.
Message Option: Select this default option to send the next reviewer an email.
Custom Message: This is the text that will appear in the message that is emailed to the reviewer
for this level.

Step 5: Add a Review Level
Click on this link to create a new review level for this workflow. Up to ten review levels may be defined.
Step 6: Submit the Form
Click on “Send Form” to send the form to the next reviewer, or click on “Cancel Form” to save the
changes made in the form without routing the form.
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4

Viewing Forms You Created

This section is for users who wish to view the forms they created. The forms may be the following
categories: Draft, Prepared, Submitted, Completed and Disapproved.

Each type of view displays different information, however, still following the same pattern as described
below:

1. Form Description: The description includes the form name, modified date, and the next approver.
2. Sort By: The drop down selection box allows you to sort the view by different categories.
3. Navigation: Navigate through each view using the First Page, Previous Page, Next Page, and Last
Page links. Each view can contain approximately 1000 entries.
4. Open Form: Click on the icon open the form.
5. Actions: Some views will allow you to perform an action. These actions will be displayed after the
title of the form. They consist of Change Reviewer, Takeback Form, Delete, Copy Form, and
Resubmit.
6. Form Data: Some forms will display a quick overview of what has been submitted.
7. Audit Trail: Clicking on the blue expansion arrow in front of the form name displays the history of the
form’s workflow actions such as approved, rerouted, or delegated, along with date and time it was
modified and the name of the person who performed the action.

User Documentation

Page 10

4.1

Draft

Displays all forms that have been saved and not submitted. This includes Fill & Print and forms that need
processing.
You can remove the form by clicking on ‘DELETE’. The form cannot be recovered after deletion.
The “COPY FORM” function allows the user to create a form based on an existing form instead of starting
from a blank form. Upon clicking on “COPY FORM”, the saved draft opens and the user can save or
submit the form to a workflow just like creating a new form. If the user chooses to save the modified
document, it will be saved as a new copy instead of overwriting the saved draft.
Note: Forms in Draft view do not have audit trails because these forms have not started the process.

4.2

Prepared

Displays all forms that you have prepared for someone else. When you submit a form, you will see an
option that says “make the next reviewer the author of the form” on the submit screen. Choosing this
option will designate you as the preparer of the form and set the next user as the author. This option is
only available for the requestor of the form.
After the form is submitted, it may only be seen in the Prepared view under FORMS YOU CREATED.
The “COPY FORM” function allows the user to create a form based on an already prepared form instead
of starting from a blank form. Upon clicking on “COPY FORM”, the prepared form opens and the user
can save or resubmit the form to a workflow just like creating a new form. If the user chooses to save the
modified form, the saved form will be listed in the “Draft” view under FORMS YOU CREATED.

4.3

Submitted

Displays all forms that you have submitted, had prepared for you, or that are waiting for approval.
Clicking on the "CHANGE REVIEWER" link allows you to send this form to a new or different reviewer.
Clicking on the "TAKEBACK FORM" link allows you to end the form’s workflow. The form is then listed in
the “Draft” view under FORMS YOU CREATED. At this point, you may either modify the form and
resubmit it through the workflow or delete the form.
The “COPY FORM” function allows the user to create a form based on an already submitted form instead
of starting from a blank form. Upon clicking on “COPY FORM”, the submitted form opens and the user
can save or submit the form to a workflow similar to creating a new form. If the user chooses to save the
modified document, the saved form will be listed in the “Draft” view under FORMS YOU CREATED.
The “ADD / VIEW COMMENT” function allows the user to add comments to the form and allows other
users view comments added to the form.

4.4

Completed

Displays all forms that you have submitted that have gone through a complete workflow. This view
displays all documents that are approved, disapproved, cancelled, processed or completed as well as the
date that the action was performed.
The “COPY FORM” function allows the user to create a form based on an already completed form instead
of starting from a blank form. When the user clicks on “COPY FORM”, the completed form opens, and
the user can save or resubmit the form to a workflow just like creating a new form. If the user chooses to
save the modified document, the saved form will be listed in the “Draft” view under FORMS YOU
CREATED.
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4.5

Disapproved

Displays all forms created by the current user which have been disapproved. The "RESUBMIT FORM"
option allows you to submit a new form with the data from the previous form already filled in. Upon
clicking on “RESUBMIT FORM”, the disapproved form opens and the user can save or resubmit the form
to a workflow just like creating a new form.
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5

Reviewing/Approving Forms

inFusion eForms provides “views” to help you navigate within the
application. Clicking on one of these views will display different forms or
information in the display section. Views are centered on three main
activities: creating a form, users viewing their forms, and approvers viewing
their forms.
This section is for approver’s reviewing their forms. It includes Approved,
Batch Approval Forms, Disapproved, and Awaiting Your Approval.

Each type of view displays different information, however, still following the same pattern as described
below:

1. Form Description: The description includes the form name, modified date, and the next approver.
2. Sort By: The drop down selection box allows you to sort the view by different categories.
3. Navigation: Navigate through each view using the First Page, Previous Page, Next Page, and Last
Page links. Each view can contain approximately 1000 entries.
4. Open Form: Click on the icon to open the form.
5. Actions: Some views will allow you to perform an action such as: Change Reviewer, Takeback Form,
Copy Form, and Resubmit (only when a form has been disapproved).
6. Form Data: Some forms will display a quick overview of what has been submitted.
7. Audit Trail: Clicking on the blue expansion arrow in front of the form name displays the history of the
form’s workflow actions such as approved, rerouted, or delegated, along with date and time it was
modified and the name of the person who performed the action.
8. Batch Processing: In the “Awaiting Your Approval” view under FORMS YOU REVIEWED, reviewers
can approve multiple forms at the same time. See section 5.2 Batch Approval Forms for more
information.

5.1

Awaiting Your Approval

Displays all forms that are waiting for you to approve or
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Clicking the "CHANGE REVIEWER" link allows you to send this form to a different reviewer without
incrementing the review level. Click on the icon to open the form.
The “ADD / VIEW COMMENT” function allows the user to add comments to the form and allows other
users view comments added to the form.
5.1.1

Entering Data in a Form

Information entered by the document author and reviewers will be visible in the form. Depending upon
the form, these fields and others may or may not be available to be edited. To enter information, navigate
to the field by pressing the tab key or clicking the mouse into the field, and begin typing. Use to the
mouse to select checkbox and select box values. Review all data and fill out any fields which may need
information.
If you are going to “Approve” the form, you will have to sign it. Click on the Sign button.
Some forms may have multiple signature fields; make sure to pick the appropriate signature block.
Your “electronic” signature and date are added to the form. When you click the sign button, other fields
may become editable; be sure to fill them out.

5.1.2

Selecting a Form Action

When ready to submit a form, you will need to choose an action in the “Select an Option” drop down
menu, usually located at the top right corner of the page. For a form in an active workflow, the following
options may be available:
Exit Without Saving: Closes the form without saving any data and returns you to the list of forms.
Approve: Approves the form. Form will be listed in the “Approved” view under FORMS YOU CREATED.
Disapprove: Disapproves the form. Form will be listed in the “Disapproved” view.
Cancel: Cancels the form and ends the workflow.
Complete: Ends the workflow and changes the form status to Complete.
Process: Ends the workflow and changes the form status to Process.
Review: Reviews the form without modifying any data.
Request Information: Requests information from a user without taking an action such as approve or
disapprove. Once the user has reviewed the form, it is routed back to the original reviewer.
Respond: When a reviewer selects the “Request Information” option, this option routes the form back to
the original reviewer.
Reroute: Routes the form to new approver without approving the form or incrementing the review level.
Submit: Submits the form to the next reviewer.
Save: Saves the form and suspends workflow. Form will be listed in the “Draft” view under FORMS YOU
CREATED.
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<Action> with Options: Before taking an action on the form, you will be given the option to add
attachments, images, or comments. See section 2.3.1 for more information.
View Attachments: If a prior reviewer or the document author added attachments, images, or comments,
this will allow the current reviewer to view this additional information.
Save Local PDF: This option is only available to PDF forms. The system will email current user a copy
of the PDF form. The emailed version cannot be edited.

5.2

Batch Approval Forms

Displays the same forms that you see in the “Awaiting Your Approval” view, however, forms can only be
reviewed one at a time in the “Awaiting Your Approval” view. In “Batch Approval Forms” view, you can
approve multiple forms at the same time.
5.2.1

What Forms Can Be Batch Approved

In order to successfully batch approve the forms, the system needs to be able to determine the next
reviewer without prompting the user to choose the next reviewer. Batch approving forms enables the
user to approve multiple forms quickly. If the system cannot determine a forms next reviewer, the form will
be skipped in the batch approval process and will have to be approved individually.
5.2.2

How to Batch Approve Forms

1. Check the checkboxes in front of the forms to batch approve.
2. Click on the “Batch Approve Selected Documents” link to start the batch approve process.
3. A status window will indicate how many forms were successfully approved, and how many forms
were skipped.
4. If a form is approved through the batch approve process, it will appear in the Forms you approved
view. Where appropriate, your signature will be inserted into the form.
5. If a form could not be successfully batch approved, you will receive an email with a link to each form.

5.3

Approved

Displays all forms that have been approved by you. It also indicates who the next approver is.
You can open the file by clicking on the icon. However, because you are not the current reviewer, you
cannot make any change to the form, and you will only see the “Exit Without Saving” option.

5.4

Disapproved

Displays all forms that you have disapproved. You can open the file by clicking on the icon. However,
because the workflow is completed, you can no longer make changes to the form. The only Form Action
available to you is “Exit Without Saving”.
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6

Searching

Search will help you quickly locate forms. There are two types of searches: Basic and Advanced.

6.1

Basic Search

Basic Search allows you to perform key word search on forms within the current view. Type the search
text into the search field, e.g. training.
•

Press Enter or click on the arrow next to the search box to begin your
search.

•

The screen will refresh, displaying the search results. As in the example,
two forms were found containing the word “training”.

•

Forms that contain the exact search text are returned. The results will not include variations or
partial matches of the search text, i.e. the search of “request” will return the "Request for Leave”
form. However, the search of “quest” will not return the “Request for Leave” form.

Matching forms are sorted by relevance (as determined by the application). The darkened box to the left
of the icon indicates how strong a match each document is. A black box indicates a strong match; a light
gray box indicates a weak match.
To view the returned form, click on the icon.

6.2

Advanced Search

Advanced Search allows you to search by text, form name, form number,
modified date, etc. The more criteria you select, the narrower your search
will be and the more accurate the results it will return. Click on the
‘Advanced’ link to perform Advanced Search.
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Step 1: Set the Search Criteria
Use as many or as few options as needed. Criteria pick lists can be changed to fit each unique search.
Choose the search criteria and enter the data for which to search.
Text: Allows you to display forms that contain or do not contain specific words.
Author: Allows you to display forms authored or not authored by specific individuals. Click the green
open book icon to select names from a list of existing users.
Date Created/Date Modified: Allows you to display forms based on date information. Enter the desired
date in the format MM/DD/YYYY, e.g. 11/28/2007. To select a date from a calendar, click the calendar
icon next to the date field.
Field: Allows you to display forms based on values within the fields of the forms. When the field option is
selected from the criteria pick list, a designated area below the pick list is displayed where you should
enter the name of the field. If you do not know the fieldname, use the text options to search all fields.
Form Name: Allows you to display forms that contain or do not contain specific words in the form name or
title. The text criterion is used with the "CONTAINS"/"DOES NOT CONTAIN" options. To select a form
name from a list, click the icon next to the form name field, and a selection window appears.
Form Number: Allows you to display forms that contain or do not contain specific numbers in the form
number.
Form File Name: Allows you to display forms that contain or do not contain the file name.
Option Pick Lists: These pick lists allow you limit/expand the scope of the search criteria described
above. The options contain two different types depending on the criteria selected. Searching by date will
provide six options, “IS ON”, “IS AFTER”, “IS BEFORE”, “IS BETWEEN”, “IS NOT BETWEEN”, and “IS
NOT ON”. The remaining search options will provide 2 options; “CONTAINS”/”DOES NOT CONTAIN”.
Selecting contains will only show those forms which contain the value specified.
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Boolean Pick Lists: Use the Boolean pick lists to join different search criteria together. The Boolean
operators are: AND, OR, and NOT. For instance, searching for text using the criteria “contains” training
authorization and the Boolean operator NOT with the Author criteria “contains” Joe Smith , The results will
return all forms containing the words training authorization that were not authored by Joe Smith.
Step 2: Set the Search Result Output Options
Maximum: Enter the maximum number of forms that you want displayed. Leaving this field blank lists all
forms found by the search on one page.
Sort Results: Determines which forms to display first. Selecting “newest first”, will display the most
recently created forms at the top of the search results page.
Include Audit Trail in Results: When this option is selected, the search results will also include the audit
trail.

Step 3: Set the Search Rules
Find Variants: If you check the “find variations” check box, the search finds documents that contain
variants of the words in your search. For instance, a search for the word “create” will also find documents
that contain the words: creates, creating, created, and creator.
Find Similar: If you check the “find similar” check box, the search finds documents that contain similar
words to the words in your search. For instance, a search for Domino Administrator will also find such
phrases as Domino System Administrator and Domino Administration.
Step 4: View the Search Results
Click the search icon to execute your search. The results display the form number and name of the form.
Click on the icon to open the form. Matching forms are sorted by relevance (as determined by the
application). The darkened box to the left of the icon indicates how strong a match each document is. A
black box indicates a strong match; a light gray box indicates a weak match. To view the returned form,
click on the icon.
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7

Troubleshooting

This page provides general tips to help you solve problems when using inFusion eForms.

7.1

Contact Information

While this documentation provides the information you need to understand and administer inFusion
eForms, there may be times when additional information or assistance is needed.
• If your inFusion eForms was purchased from an inFusion eForms Business Partner, please
contact the Business Partner for technical support. Your administrator will have all the
contact information that you need.
• Otherwise, send your questions directly to info@itmassociates.com.
ITM will provide timely responses to support questions from inFusion eForms users that have purchased
a Maintenance Agreement.
For the latest information on ITM’s products and services, please visit www.itmassociates.com.

7.2

FAQ

 I encountered a delay in opening PDF forms. Only a blank screen is displayed.
If Acrobat or Adobe Reader has been newly installed, make sure users have opened the application
before trying to launching inFusion eForms.
This may also happen if Acrobat or Reader has “check for updates” set to automatic. The dialog may
then open in the background, which will delay opening a PDF. To turn off automatic updates, go to
Edit > Preferences > Updates, set “Check for Updates” to manual.
 When using Adobe Reader 6.0 and inFusion eForms, I received the following message:

inFusion eForms provides functionality to save data. Simply choose “Do not show this message
again”, and click “OK”.
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 When using Adobe Acrobat 6.0 or Reader 6.0, I received the following dialog:

inFusion eForms does not require Auto-Complete. Users can choose Yes or No to enable or disable
the feature.
 The PDF form did not open within Netscape Navigator. I encountered an error. Sometimes the
form opened using the built-in Acrobat/Reader.
Please refer to this link http://www.adobe.com/cfusion/knowledgebase/index.cfm?id=328635 from
Adobe’s support site to configure Netscape Navigator properly.
 When using Acrobat 5.0, I received the following dialog:

You should check with the form creator to see if any Acrobat 6 specific features have been used. In
most cases click OK, and the form will be accessible.
 Opening an inFusoin eForms link from an e-mail message did not open the PDF form.
Make sure Lotus Notes is set to open the link with your browser.
 I kept getting a login prompt when trying to view a PDF form.
Make sure the signer of the agents is in the ACL with at least ‘Editor’ access.
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 When opening a form I received one or both of the following errors.

inFusion eForms requires the PDFs to be opened within a browser window. This setting can be
selected under the following:
Acrobat 5.x:
• Open Acrobat, go to Edit > Preferences > General >Options, make sure the "Display PDF in
Browser" is checked.
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Acrobat 6.x
• Open Acrobat, go to Edit > Preferences > Internet, make sure the "Display PDF in Browser"
is checked.

•

If you are running more than one version of Acrobat, you should remove all versions of
Acrobat and install only one version.

 When opening a PDF Form, it opens in a new Internet Explorer Window.
This is an Internet Explorer setting. Go to Tools > Internet Options > Advanced, check the option
“Reuse windows for launching shortcuts.”
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 How to install different versions of Adobe Acrobat on one machine.
In order to successfully install multiple versions of Adobe Acrobat, perform the following steps.
•
•
•
•
•

Install Adobe Acrobat 5 first, in c:\Program Files\Adobe\Acrobat 5.0
Restart machine. Open Acrobat. Make sure PDF opens in browser.
Install Adobe Reader 6, in a separate folder such as c:\Program Files\Acrobat 6.0. Do not
install it in the same Adobe folder or in the Acrobat 5.0 folder.
Restart your machine
Open Reader 6.0 manually. Open PDF in Browser. It will open in Reader 6.

NOTE: Acrobat 5 and Reader 7.0 do not work consistently when installed on the same machine
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